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Chapter 1

1: Introduction & Installation

INTRODUCTION

HART® SNAP I/O modules for analog current input and output provide communication with other Highway 
Addressable Remote Transducer (HART) current loop devices. 

Two modules are available:
• The SNAP-AIMA-iH analog input module provides two channels of isolated current input with a range 

of 4–20 mA. External loop power supplies are required for current loops. This module is categorized by 
the HART protocol as a current input connection type, which means that the module is a low impedance 
device. 

• The SNAP-AOA-23-iH analog output module provides two channels of isolated current output with a 
range of 4–20 mA. External loop power supplies are required for current loops. This module is 
categorized by the HART protocol as a current output device, which means that each channel controls 
the loop current and is a high impedance device. 
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HART SNAP I/O modules mount on SNAP PAC racks alongside other SNAP I/O modules (analog, digital, and 
serial), so you have the combination of I/O you need at any location. The rack requires a SNAP PAC brain or 
rack-mounted controller for I/O processing and communications. 

Designed to be part of the SNAP PAC System, HART SNAP I/O is most easily used with a SNAP PAC controller 
and PAC Control software, which includes specific commands for use with the HART protocol. Sample 
subroutines and a flowchart can be downloaded free from our website to give you a head start on 
communicating with HART smart devices.

HART SNAP I/O can also be used without PAC Control in a custom program you develop using our free HART 
Developer Toolkit, also available on our website, www.opto22.com. 

What’s in this Guide?

This guide assumes that you are familiar with the HART protocol and Opto 22’s SNAP PAC System. Online 
resources are available for learning about HART. A good place to start is here on the HART Communication 
Foundation website: http://en.hartcomm.org/hcp/tech/aboutprotocol/aboutprotocol_what.html 

To learn more about the SNAP PAC System, visit the Opto 22 website at www.opto22.com.

This guide includes the following chapters:
• Chapter 1: Introduction & Installation—How HART SNAP I/O works with HART devices; installation; 

specifications
• Chapter 2: Using HART SNAP I/O with PAC Control—Using PAC Control sample subroutines and 

HART commands in PAC Control
• Chapter 3: Using HART SNAP I/O with a Custom Program—Resources for configuring modules and 

communicating with them using a program built with our Developer’s Toolkit

For Help

If you have problems installing or using SNAP serial communication modules and cannot find help in this 
guide or on our website, you can contact Opto 22 Product Support. 

Phone: 800-TEK-OPTO (800-835-6786 toll-free 
in the U.S. and Canada)
951-695-3080
Monday through Friday, 
7 a.m. to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: www.opto22.com

When calling for technical support, be prepared to provide the following information about your system to 
the Product Support engineer:
• Software and version being used
• Controller firmware version (if applicable)
• PC configuration
• A complete description of your hardware, including:

– IP addresses and net masks for devices on the system
– type of power supply (brand and model)
– types of I/O units installed

NOTE: Email messages and phone calls 
to Opto 22 Product Support are 
grouped together and answered in the 
order received.

mailto:support@opto22.com
https://www.opto22.com
https://www.opto22.com/support/resources-tools/downloads/paccontrolhartsubroutines-zip
https://www.opto22.com/support/resources-tools/downloads/paccontrolhartsubroutines-zip
http://en.hartcomm.org/hcp/tech/aboutprotocol/aboutprotocol_what.html 
https://www.opto22.com/products/pac-dev-hart-dotnet
https://www.opto22.com/products/pac-dev-hart-dotnet
https://www.opto22.com/products/product-families/snap-pac-system
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– third-party devices installed (for example, barcode readers)
– jumper configuration, if applicable
– accessories installed (such as expansion cards)

• Specific error messages seen.

ABOUT HART AND HART SNAP I/O

The HART (Highway Addressable Remote Transducer) protocol is used for sending and receiving digital 
information across analog wires (4–20 mA loops). HART devices are a combination of a digital communication 
device and a 4–20 mA analog device.

A 4–20 mA loop can have one or more 4–20 mA receivers, but only one 4–20 mA transmitter (that is, only one 
device can drive the 4–20 mA current). 

Transmitters vs. Actuators

HART field devices are generally categorized as transmitters or actuators (receivers):
• Transmitters transmit, or drive, the 4–20 mA current.  
• Actuators (receivers) receive the 4–20 mA signal. 

A receiver is called an actuator because most third-party HART devices are field devices that have HART 
capability built in, for example, a valve or motor with a HART interface. So the HART actuator is typically a field 
device that is actuated based on what it receives via the HART interface.

From an electrical standpoint:
• The SNAP-AOA-23-iH output module is a transmitter because it is transmitting the 4–20 mA signal. It 

should only be used in loops with HART actuators (receivers), since actuators do not try to set the analog 
loop current.

• The SNAP-AIMA-iH input module is an actuator because it receives the 4–20 mA signal. It can be used in 
a loop with a transmitter and other actuators.

NOTE: Our implementation is different from other HART devices that interface with field signals in that the "field" side 
of our HART modules is actually the SNAP PAC brain. The HART side is the 4–20 mA side.

HART on the Modules

Each channel on each module features an integrated HART modem that allows the channel to communicate 
digitally with a HART FSK (frequency-shift keying) signal superimposed onto the analog 4–20 mA current 
loop. The channel is a master device when used together with SNAP PAC brains or controllers to communicate 
with other HART current loop devices in either point-to-point or multidrop configurations. 

The SNAP-AOA-23-iH and SNAP-AIMA-iH differ only in their analog function (4–20 mA input or output). The 
HART component is the same for both modules. The parameters they can read and write using HART depend 
on the other HART devices they are communicating with. 
• If the connected device is an actuator (receiver), you can write and read process variables (with 

Command 79 or a device-specific command) to control the field output of the device. Most HART 
actuators are like a converter taking in a HART signal and sending out an analog field signal.

• If the connected device is a transmitter, you can only read process variables, since the transmitter only 
reads in field values and does not output them. Most HART transmitters are like a converter taking in an 
analog field signal and sending out a HART signal.
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For configuring, you can use HART to read and write configuration data for any HART device using Commands 
0 and 13 or many of the Common Practice Commands. For more information on the HART protocol, visit: 
http://en.hartcomm.org/hcp/tech/aboutprotocol/aboutprotocol_what.html 

INSTALLATION 

HART SNAP I/O modules mount on SNAP PAC racks with other SNAP I/O modules (analog, digital, and serial). 
These modules require a SNAP PAC brain or rack-mounted controller. They are not compatible with legacy 
brains and controllers.

Install the Module

HART SNAP I/O modules can be installed in any position on an Opto 22 SNAP PAC mounting rack.
1. Turn off power to the rack. 

WARNING: Make sure power is off before continuing, or you will severely damage the module.

2. Remove the module from its packaging. 
3. Position the module over the connector 

on the rack, aligning the small slot at the 
base of the module with the retention 
bar on the rack. 
If it is next to another module, make sure 
the male and female module keys are 
aligned, as shown at right.

4. Push straight down on the module to 
snap it into position.

5. Use two standard 4-40 x 1/4 truss-head 
Phillips holddown screws to secure both 
sides of each module.

CAUTION: Do not over-tighten screws. See 
“Specifications” on page 7.

If you need to remove the module, see 
page 7. 

http://en.hartcomm.org/hcp/tech/aboutprotocol/aboutprotocol_what.html 
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Wire the Module

Standard wiring for typical use is shown on this page. 

87654321

CH 0 CH 1

TTransmitter
+

+

–

–

External Loop 
Power Supply

CH 0
1 2

Transmitter +

+

–

–

External Loop 
Power Supply

CH 0
1 2 3 4

Transmitter

–

+

+

–

External Loop 
Power Supply

CH 0
1 2

TT

OR OR

SNAP-AIMA-iH
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RReceiver
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External Loop 
Power Supply
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Receiver +
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–

–
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Power Supply
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–
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+
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Power Supply
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Alternate Wiring Diagram

Wiring shown on the previous page is typical use. 

The wiring on this page is nonstandard. Use this page if: 
• You are using the HART protocol but not using the analog signal.
• Your HART network includes too many devices for a standard 4–20 mA loop.

This alternative wiring makes sure all HART devices on your network have adquate power.

Multidrop Wiring—SNAP-AIMA-iH

CH0
+

–

+

–

+

–

SNAP-
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DC 
Power 
Supply

R
+

–
R

+

–
R

Multidrop Wiring—SNAP-AOA-23-iH
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+

–

+

–
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DC 
Power 
Supply

T
+

–
T

+

–
T

230-600 Ohms
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Apply Power to the Rack

Power can usually be supplied by an Opto 22 SNAP-PS5 power supply; however, check total power 
requirements for all modules and the processor. 

What’s Next

If you’re using PAC Control, continue with Chapter 2: Using HART SNAP I/O with PAC Control 

If you’re building a custom program, skip to Chapter 3: Using HART SNAP I/O with a Custom Program 

Removing a SNAP I/O Module

To remove a module, use the SNAP 
module tool that came with the module.
1. Turn off power to the rack. 

WARNING: Make sure power is off 
before continuing, or you will severely 
damage the module.

2. Remove the module’s two holddown 
screws.

3. Holding the SNAP module tool as 
shown in the illustration at right, 
insert it into the notch at the base of 
the module.

NOTE: If you are facing the rack with the 
processor on the left side, the notch is on 
the back of the module.

4. Squeeze the module tool against the 
module to open the release latch, 
and pull straight up on the module to 
remove it.

SPECIFICATIONS

SNAP-AIMA-iH Analog Input

Input Range 
Nominal
Full

4 to 20 mA 
3.2 to 24 mA

Maximum Survivable Input 40 V or 160 mA

Impedance 230 Ohms nominal

Resolution 0.8 microamps

Accuracy +/- 10 microamps

Response Time
(% of span/delta I/delta time) 99.9%/20.7mA/10 ms
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SNAP-AOA-23-iH Analog Output

Gain Temperature Coefficient 30 ppm/ °C

Offset Temperature Coefficient 15 ppm/ °C

DC Common Mode Rejection >-120 dB

AC Common Mode Rejection >-120 dB @ 60 Hz

Maximum Operating Common 
Mode Voltage 

250 V continuous
1500 V transient (1 s)

Isolation: Channel-Channel 250 V continuous
1500 V transient (1 s)

Power Requirements 5 VDC (+/- 0.15) @ 150 
mA

Ambient Temperature:
Operating
Storage

-20 °C to 70 °C
-40 °C to 85 °C

Humidity 5-95%, non-condensing

Torque, hold-down screws 4 in-lb (0.45 N-m)

Torque, connector screws 5.26 in-lb (0.6 N-m)

Agency Approvals UL, CE, RoHS, DFARS

Warranty Lifetime

Output Range
Nominal
Full

4 to 20 mA
3.2 to 24 mA

External Loop Voltage Range
Nominal

12-36 VDC
24 VDC

Maximum Load Resistance at 
Specified Loop Voltage
12 VDC
24 VDC
36 VDC

300 Ohms
850 Ohms
1350 Ohms

Resolution 5 microamps

Accuracy +/- 20 microamps

Response Time
(% of span/delta I/delta time) 99.9%/20.7 mA/400 ms

Gain Temperature Coefficient -50 ppm/ °C

Offset Temperature Coefficient -25 ppm/ °C

DC Common Mode Rejection >-120 dB

AC Common Mode Rejection >-120 dB @ 60 Hz

Maximum Operating Common 
Mode Voltage 

250 V continuous
1500 V transient (1 s)

Common Mode Resistance >1000 megohms

Isolation: Channel-Channel 250 V continuous
1500 V transient (1 s)

Power Requirements 5 VDC (+/- 0.15) @ 150 mA
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LEDs

Each module includes four LED indicators on the top of the module. LEDs 1 and 3 refer to channel 0; 
LEDs 2 and 4 refer to channel 1. 

Ambient Temperature:
Operating
Storage

-20 °C to 70 °C
-40 °C to 85 °C

Humidity 5-95%, non-condensing

Torque, hold-down screws 4 in-lb (0.45 N-m)

Torque, connector screws 5.26 in-lb (0.6 N-m)

Agency Approvals UL, CE, RoHS, DFARS

Warranty Lifetime

LED 1 or 2 
Status 

LED 3 or 4 
Activity 

Description

Solid Green Blinking Green HART channel is operational; loop voltage and current are within limits.

Solid Red Blinking Red 

HART communication error: 
• On a SNAP-AOA-23-iH, check loop voltage. Excessive load resistance 

or an incorrect loop power supply may cause voltage to be too low.
• On a SNAP-AIMA-iH, check loop current to make sure it is between 

3.9 mA and 20.2 mA. 
NOTE: If loop voltage and current are correct, contact Product Support.

OFF -- Current loop open or loop voltage is zero. Implies that the channel is not 
being used. 
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Chapter 2

2: Using HART SNAP I/O with 
PAC Control

PAC CONTROL COMMANDS FOR HART SNAP I/O

HART SNAP I/O modules are designed for use with a SNAP PAC programmable automation controller and PAC 
Control automation software (version 9.4 and higher). 

Several HART-specific PAC Control commands make it possible for these modules to communicate any HART 
command that adheres to the HART request-response model or the burst message model. 

HART-specific PAC Control commands include:
• Get HART Unique Address
• Send/Receive HART Command
• Receive HART Response
• Receive HART Burst Response

In addition, you’ll use the following string commands (also in PAC Control version 9.4 and higher) to build 
parameters in HART-specific commands:
• Pack Float into String
• Pack Integer 32 into String
• Pack Integer 64 into String
• Pack String into String
• Unpack String

For details and examples on all PAC Control commands, see the Command Help in PAC Control or form 1701, 
the PAC Control Command Reference, available at www.opto22.com.

SAMPLE PAC CONTROL SUBROUTINES

In your PAC Control strategy you will need to assemble all request data sent to the module and to parse all 
response data returned by the module. Sample subroutines are available to help you see how to 
communicate with HART devices using PAC Control. They can be downloaded from our website here: HART 
Sample Subroutines for PAC Control. Or go to www.opto22.com and search on HART. 

Here’s what’s included in the download:
• 14 PAC Control subroutines—one subroutine for each of 14 universal HART commands
• An Example Chart using the subroutines

Requirements

Before using the subroutines and example strategy, you will need:

https://www.opto22.com/support/resources-tools/downloads/paccontrolhartsubroutines-zip
https://www.opto22.com/support/resources-tools/downloads/paccontrolhartsubroutines-zip
https://www.opto22.com/support/resources-tools/documents/1701-pac-control-command-reference
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• A PC running PAC Control software and the HART Sample Subroutines
• PAC Project (Basic or Pro) 9.4 or newer
• SNAP PAC controller with firmware version 9.4 or newer
• SNAP-AIMA-IH , HART communication analog 4-20 mA input module

HART Commands Supported

The following universal HART commands are supported by the PAC Control subroutines included in the 
example strategy. For details on the PAC Control variables used in each subroutine, see “HART Commands and 
Subroutine Instructions and Variables” on page 17.

Installing the Example Strategy

To install the example strategy on your computer, extract the contents of the PACControlHARTSubroutines.zip 
file to a folder on your C: drive. A good location is to create a new folder in the PAC Project installation 
directory.

Using the Subroutines

Also see form 1700, the PAC Control User’s Guide for detailed instructions on how to configure a controller, add 
an I/O unit, and use a subroutine.

Here are the basic steps to start reading data from your HART transmitter:
1. Open the strategy in PAC Control.

The following message appears.

HART 
Command

Name PAC Control Subroutine

0 Read Unique Identifier HART_Command_0_ReadUniqueDeviceID

1 Read Primary Variable HART_Command_1_ReadHartVariables

2 Read Loop Current and Percent of Range HART_Command_2_ReadLoopCurrent_RangePercent

3 Read Dynamic Variables and Loop Current HART_Command_3_ReadDynamicVAR_LoopCurrent

6 Write Polling Address HART_Command_6_WritePollingAddress

7 Read Loop Configuration HART_Command_7_ReadLoopConfiguration

8 Read Dynamic Variable Classifications HART_Command_8_ReadDynamicVariableClassifications

12 Read Message HART_Command_12_ReadMessage

13 Read Tag, Descriptor, Date HART_Command_13_ReadTAGDescriptor_Date

14 Read Primary Variable Transducer Information HART_Command_14_ReadPrimaryVariableTransducerInfo

15 Read Device information HART_Command_15_ReadDeviceInfo

16 Read Final Assembly Number HART_Command_16_ReadFinalAssemblyNumber

17 Write Message HART_Command_17_WriteMessage

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3165
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2. Click Yes to use the subroutines from the location shown on the dialog box. Or click No to specify a new 
location for each subroutine file.
Once the strategy is installed and open in PAC Control, the contents of the Subroutines Included folder 
should look like this:

3. Right-click the I/O Units folder to add an I/O unit with an installed SNAP-AIMA-iH input module and 
configure the module's points. Also make sure the control engine is properly configured. For details, see 
form 1700, the PAC Control User’s Guide.

4. In Config mode, expand the Variables folder and the Numeric Variables folder to find the nPollingAddress 
variable.

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
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5. Double-click the nPollingAddress variable and change the initial value to the transmitter’s polling 
address.
You can find the polling address in the documents included with your transmitter.

.

6. Click OK to confirm and close the dialog box.
7. Click Debug.

The code is compiled and downloaded to your controller.
8. Once that’s done, click Run Strategy.

Now that the strategy is running, you will be able to read the unique identification of your device as well 
as the Primary and Secondary variables and other status information.

9. To read the value of a variable, double-click the variable in the Numeric Variables folder or the String 
Variables folder.

Debug
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Here are some examples of the variables:

UNPACKING DATA STRINGS RECEIVED FROM HART COMMANDS

In general, in order to unpack strings returned from the HART transmitter for specific HART commands, you 
will need to know which bytes to look at. However, if you are using the sample subroutines, this is done inside 
the subroutine; the specific HART command data is unpacked and copied to a variable in the example chart to 
ease the process of reading most common HART information. For details, refer to the HART documentation 
available on the HART Communication Foundation website, http://en.hartcomm.org

Command 3 Example

This graphic shows the subroutine response for Command 3.

http://en.hartcomm.org/
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The highlighted part is where the actual data begins (byte 10). 

Command 3 fetches the following variables: Loop Current, Primary, Secondary, third and fourth Variable. These 
values can be temperature; pressure, etc. depending on the HART transmitter.

For the response (st_Comm3Res), bytes 0 - 9 are the HART header and status bytes. In the unpack command 
shown below (Command 3), it starts reading the Loop current from byte10. However, when looking at the 
HART command specification, the Loop current reads starting at byte 0 (the header is ignored). So there is an 
offset of 10 when unpacking the response in PAC Control. If the HART document states to start reading at byte 
0, that’s byte 10 in PAC Control. If the response data byte says to read byte 4, in PAC Control you start reading 
from byte 14 (for the Primary variable).
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HART COMMANDS AND SUBROUTINE INSTRUCTIONS AND VARIABLES

The command numbers are the same for all HART Transmitters. However, depending on what Dynamic 
Variables and commands a HART Device supports and the revision, the response might be slightly different 
from one device to another. Therefore, you will need to refer to the documentation for the specific HART 
transmitter being used and consider the information that is being read for that device.

Each HART command supported in the Sample Subroutines has an associated subroutine and PAC Control 
instruction. A table included with each command shows the variables used in the example chart to pass and 
receive HART information from  the subroutine. 

For additional information about the commands, see document numbers HCF_SPEC_127 and HCF_SPEC-151 
on the HART Communication Protocol website, http://en.hartcomm.org/

Command 0: Read Unique Identifier

This is an Identity Command. Returns identity information about the field device (the HART Transmitter). 
When devising a strategy to communicate with a HART transmitter, always start with Command 0 (subroutine 
HART_Command_0_ReadUniqueDeviceID) before using any of the other subroutines. Command 0 returns 
the unique ID for that device. The unique ID is used when calling a subroutine or HART command.

The Command 0 subroutine requires that you know the Polling Address of your HART Transmitter. The Polling 
Address is found in the documents provided with your transmitter. 

PAC Control Instruction: HART_Command_0_ReadUniqueDeviceID

HART Command Page

Command 0: Read Unique Identifier 17

Command 1: Read Primary Variable 18

Command 2: Read Loop Current and Percent of Range 18

Command 3: Read Dynamic Variable and Loop Current 18

Command 6: Write Polling Address 19

Command 7: Read Loop Configuration 19

Command 8: Read Dynamic Variable Classifications 19

Command 12: Read Message 20

Command 13: Read Tag, Descriptor, Date 20

Command 14: Read Primary Variable Transducer Information 20

Command 15: Read Device Information 21

Command 16: Read Final Assembly Number 21

Command 17: Write Message 21

Passed Variable Format Description

HART I/O AI HART module on the rack

nPollingAddress INT 32 Polling Address of the device

st_UniqueAddress String This is where the Unique Address is going to be saved.

nChartStatus INT 32 Chart Status 

http://en.hartcomm.org/
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Command 1: Read Primary Variable 

Reads the Primary Variable. This value is returned along with its Units Code. 

PAC Control Instruction: HART_Command_1_ReadHartVariables

Command 2: Read Loop Current and Percent of Range

Reads the Loop Current and its associated Percent of Range. The Loop Current always matches the current that 
can be measured by the SNAP-AIMA-IH module. 

PAC Control Instruction: HART_Command_2_ReadLoopCurrent_RangePercent

Command 3: Read Dynamic Variable and Loop Current

Reads the Loop Current and up to four predefined Dynamic Variables.

PAC Control Instruction: HART_Command_3_ReadDynamicVAR_LoopCurrent

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

n_COMD_1_PrimVar_Unit INT32 Unit of Primary Variable

ft_COMD_1_PrimVar Float Primary Variable

st_Comm1Res String Entire Response 

nChartStatus INT 32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

st_empty String

ft_COMD_2_LoopCurrent Float Primary variable Loop Current: 4 - 20mA

ft_COMD_2_PrimVarPercent Float Primary variable Percent of Range (units of Percent)

st_Comm2Res String Entire Response 

nChartStatus INT 32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

ft_COMD_3_LoopCurrent Float Primary variable Loop Current: 4 - 20mA

n_COMD_3_PrimaryVariable_UnitCode Int32 Primary Variable Unit Code

ft_COMD_3_PrimVar Float Primary variable 

n_COMD_3_SecondaryVariable_UnitCode Int32 Secondary Variable Unit Code

ft_COMD_3_SecVar Float Secondary variable

n_COMD_3_TertiaryVariableUnitCode Int32 Tertiary variable Unit Code

ft_COMD_3_TertiaryVariable Float Tertiary variable

n_COMD_3_QuaternaryVariableUnitCode Int32 Quaternary variable Unit Code

ft_COMD_3_QuaternaryVariable Float Quaternary variable

st_Comm3Res String Entire Response 

nChartStatus Int32 Chart Status 
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Command 6: Write Polling Address

Writes the polling address and the loop current mode to the field device. 

PAC Control Instruction: HART_Command_6_WritePollingAddress

Command 7: Read Loop Configuration

Reads the polling address and the loop current mode.

PAC Control Instruction: HART_Command_7_ReadLoopConfiguration

Command 8: Read Dynamic Variable Classifications

Reads the Classification associated with the Dynamic Variables

PAC Control Instruction: HART_Command_8_ReadDynamicVariableClassifications

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

nPer_COMD_6_PollingAddress Int32 Polling Address of Device

st_Comm6Res String Entire Response 

nChartStatus Int32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

st_empty String

n_COMD_7_PollingAddress Int32 Polling Address

n_COMD_7_LoopCurrentMode Int32 Loop Current Mode

st_Comm7Res String Entire Response 

nChartStatus Int32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

St_empty String -

n_COMD_8_PrimaryVarCalssification Int32 Primary Variable Classification

n_COMD_8_SecondaryVarCalssification Int32 Secondary Variable Classification

n_COMD_8_TertiaryVarClassification Int32 Tertiary variable Classification

n_COMD_8_QuaternaryVarClassification Int32 Quaternary variable Classification

st_Comm8Res String Entire Response 

nChartStatus Int32 Chart Status 
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Command 12: Read Message

Reads the Message contained within the device.

PAC Control Instruction: HART_Command_12_ReadMessage

Command 13: Read Tag, Descriptor, Date 

Read Tag, Descriptor, Date contained within the device. Only the Tag (6 Bytes or 8 Packed ASCII Characters) is 
processed by this subroutine. 

PAC Control Instruction: HART_Command_13_ReadTAGDescriptor_Date

Command 14: Read Primary Variable Transducer Information 

Reads the Transducer Serial Number, Limits/Minimum Span Units Code, Upper Transducer Limit, Lower 
Transducer Limit and Minimum Span for the Primary Variable Transducer. 

PAC Control Instruction: HART_Command_14_ReadPrimaryVariableTransducerInfo

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

st_empty String

st_COMD_12_MessageRead String Message Read

st_Comm7Res String Entire Response 

nChartStatus Int32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

st_empty String -

st_COMD_13_TAG String Tag

st_COMD_13_Descriptor String Descriptor

st_COMD_13_Date String Date 

st_Comm13Res String Entire Response 

nChartStatus Int32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

St_empty String -

n_COMD_14_TransducerSerialNumber Int32 Serial Number

n_COMD_14_TransducerLimits_SpanUnitCode Int32 Limits and Minimum Span Unit Code

ft_COMD_14_UpperTransducerLimit Float Upper Limit

ft_COMD_14_LowerTransducerLimit Float Lower Limit

ft_COMD_14_MinimumSpan Float Minimum Span

st_Comm14Res String Entire Response 

nChartStatus Int32 Chart Status 
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Command 15: Read Device Information 

Reads the alarm selection code, transfer function code, range values units code upper range value, Primary 
Variable lower range value, damping vale and write protect code.

PAC Control Instruction: HART_Command_15_ReadDeviceInfo

Command 16: Read Final Assembly Number

Reads the final assembly number associated with the device. 

PAC Control Instruction: HART_Command_16_ReadFinalAssemblyNumber

Command 17: Write Message 

Writes the Message into the device. To write a message to the transmitter or use Command 17, you need to 
move the message to the variable (st_COMD_17_MessagetoWrite). Command 17 accepts messages that are 
exactly 32 characters to write to the transmitter.

PAC Control Instruction: HART_Command_17_WriteMessage

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

St_empty String -

n_COMD_15_AlarmSelectCode Int32 PV Alarm Selection Code

n_COMD_15_TransferFunctionCode Int32 PV Transfer Selection Code

n_COMD_15_UpperLowerRangeValuesUnitCode Int32 PV Upper /Lower Range Values Unit Code

ft_COMD_15_UpperRangeValue Float PV Upper Range Value

ft_COMD_15_LowerRangeValue Float PV Lower Range Value

ft_COMD_15_DampingValueUnitSeconds Float PV Damping Value

n_COMD_15_WriteProtectCode Int32 Write Protect Code

n_COMD_15_AnalogChannelFlags Int32 PV Analog Channel Flags

st_Comm15Res String Entire Response 

nChartStatus Int32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

st_empty String -

n_COMD_16_FinalAssemblyNumber Int32 Final Assembly Number

st_Comm16Res String Entire Response 

nChartStatus Int32 Chart Status 

Passed Variable Format Description

HART I/O AI HART module on the rack

st_UniqueAddress String Unique Address of the device

st_COMD_17_MessagetoWrite* String Message to write.

st_Comm17Res String Entire Response 

nChartStatus Int32 Chart Status 

* Note: The Message string must be exactly 32 string characters. 
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Chapter 3

3: Using HART SNAP I/O with a 
Custom Program

RESOURCES FOR CUSTOM PROGRAMMING

HART SNAP I/O modules are typically used with an Opto 22 PAC Control strategy running on a SNAP PAC 
programmable automation controller. If you’re not using PAC Control, however, you can develop your own 
custom program. Here’s what you’ll need:
• One or more HART SNAP I/O modules on a SNAP PAC rack with a SNAP PAC I/O processor (brain or 

rack-mounted controller). See Chapter 1: Introduction & Installation 
• The free SNAP PAC .NET HART developer toolkit. This toolkit lets you integrate HART SNAP I/O modules 

into an existing .NET/Mono application. This toolkit is available for download on www.opto22.com. It 
includes complete documentation.

• PAC Manager software. This free configuration and troubleshooting utility is available for download on 
our website, www.opto22.com. Install PAC Manager on a Windows PC on the same Ethernet network as 
the I/O unit. The PAC Manager User’s Guide (form 1704) is included.

• The OptoMMP Protocol Guide (form 1465, available on www.opto22.com). OptoMMP is the memory map 
protocol used by SNAP PAC I/O processors. This guide shows you how to address modules on the rack 
and includes the complete memory map, which provides the addresses you’ll use to configure and 
communicate with HART SNAP I/O modules.

GETTING STARTED

Get Acquainted

In Chapter 2 of the OptoMMP Protocol Guide, read “Overview of Programming,” “Understanding the Memory 
Map,” and “Referencing SNAP I/O Points.”

Assign an IP Address

If the SNAP PAC I/O processor doesn’t have a fixed IP address yet, follow steps in the PAC Manager User’s Guide 
to assign it.

Configure I/O Points

You can configure the two points on the HART SNAP I/O module in your custom program or in PAC Manager 
software. 

https://www.opto22.com/products/pacmanager
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
https://www.opto22.com/products/pac-dev-hart-dotnet
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In your program

1. If you want to configure analog point features—watchdog, custom scaling, or output clamping—on 
HART SNAP I/O modules, follow instructions in “Using I/O Point Features” (in Chapter 2 of the OptoMMP 
Protocol Guide). 
If you’re not using these features, you do not need to configure points. The I/O processor recognizes 
points automatically. 

2. Configure HART settings using the memory map section, “HART Module Configuration—Read/Write” in 
the Memory Map Appendix.

NOTE: The only thing you cannot configure in your custom program is a change to the IP port number used by 
one of the module’s points. If you need to change the IP port number, use PAC Manager and remember to save 
the configuration to flash memory. You must reboot the I/O processor for the change to take effect. 

In PAC Manager—Inspect Window

For individual I/O units, use the steps shown below. If you have several similar I/O units, you may prefer to 
create a configuration file and download it to several I/O units at once. For this option, see “In PAC Manager—
Configuration File” on page 27.
1. On the PC, choose Start > Programs > Opto 22 > PAC Project > PAC Manager.

2. In the PAC Manager main window, click Tools > Inspect. 
If this is the first time you’ve used the Inspect window, it will be blank as shown below. If you’ve used it 
before, PAC Manager will try to connect to the last device you inspected and read its status. 
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3. In the Device Name field, enter the IP address you’ve assigned to the I/O unit with the HART module. 
4. Click the Point Config button in the left column. Click the module number and then the point you want 

to configure.

5. If necessary, change Offset, Gain, Upper and Lower Scaled Units, and Filter Weight. When finished, click 
Apply.

6. In the left column, click Communications > HART Modules.
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7. Choose the module number from the dropdown list. Remember that the first module on the rack is 
numbered 0.

8. Set parameters for each port to match the HART device it will communicate with:

9. When everything is correct, click Apply.
The configuration is sent to the I/O unit BUT is not saved to flash memory. If the I/O unit loses power or is 
turned off, you will have to reconfigure the HART modules.

Parameter Description Default

Port Number TCP port number. NOTE: If you change the port number you 
must restart the I/O unit after you finish configuration.

See table on 
page 31

Primary Master

Master Address. 0 = Secondary Master, 1 = Primary Master 
Use 1 if you want the HART SNAP I/O module to be the per-
manent master; you can temporarily attach another master 
device for configuration or troubleshooting.

1

Retry Limit
Number of times to retry communication. Valid values: 0 to 5
If the module does not receive a valid response from the slave 
device after the maximum number of retries, it reports an error.

2

Burst Message
0 = Don't report burst messages, 1 = Report burst messages
Burst messages occur when a slave device in a special mode 
sends data without a request from a master.

0

Promiscuous Mode

0 = Don't report other master requests/responses, 
1 = Report other master requests/responses
1 means that the module will report transactions initiated by 
the other master, including requests and responses.

0

Preambles Count
Valid values: 5 to 20
Older HART devices may requre more than 5 preamble char-
acters. Verify using HART command 0.

5

Choose module number.
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10. When you’ve finished configuring modules, save the configuration to flash:
a. Click Status Write in the left column.
b. In the Operation area halfway down the window, highlight Store configuration to flash. 

c. Click Send Command. 
d. IMPORTANT: If you have changed the TCP port number, highlight the operation Restart Device 

from powerup, and click Send Command again. 
The configuration is stored to the I/O unit’s flash memory, and you’re ready to use the module.

In PAC Manager—Configuration File

If you have several similar I/O units, you can create a configuration file (also called a tag database) and 
download it to several I/O units at once. A sample configuration file is included in the Developer’s Toolkit, 
which you can modify as needed. Or follow these steps to create a new file.
1. On the PC, choose Start > Programs > Opto 22 > PAC Project > PAC Manager.
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2. In the PAC Manager main window, click the New button or choose File > New and create a new tag 
database (configuration file). 

3. In the tree, double-click the I/O Units folder. Follow steps in the PAC Manager User’s Guide to add the I/O 
unit and configure its I/O modules and points. The SNAP-AIMA-iH is an analog input module; the 
SNAP-AOA-23-iH is an analog output module.

4. In the Configure I/O Units dialog box, highlight the I/O unit the HART module is on and click the Modules 
button.
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5. Choose HART Modules from the pop-up menu. 

6. In the Number field, choose the HART module’s position from the drop-down list. Click to put a check 
mark in the Used box. 

7. Configure all parameters for each port used.
– Port Number: If you need to change port numbers, enter a new number for each port in the Port 

Number field.
– Primary Master: 0 = Secondary Master, 1 = Primary Master

A master is a device that is in control of the HART Bus.  Either master (Primary or Secondary) can 
initiate a transaction with a slave field device attached to the bus.
If you want a permanent master connected to the HART bus, use Primary Master = 1. This allows you 
to temporarily attach another master device to configure a device or troubleshoot the HART bus.

Modules 
button
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– Retry Limit: 0, 1, 2, 3, 4, or 5
If the module does not receive a valid message from the slave device it is talking to, it will 
automatically send up to the configured number of retries until it gets a valid response. If it does not 
get a valid response after the maximum number of retries, it will report back that an error occurred.

– Burst Message: 0 = Don't report burst messages, 1 = Report burst messages
A burst message occurs in a special mode where one slave device on the HART Bus is periodically 
sending data without a request generated by a master device. 

– Promiscuous Mode: 0 = Don't report other master requests/responses, 1 = Report other master 
requests/responses.
When enabled (1), the module reports transactions initiated by the other master on the bus, 
including requests generated by the other master and responses to those requests by the addressed 
slave. 

– Preambles Count: 5 to 20
Preamble characters are sent with every message to indicate that data is about to be transmitted. 
The default of 5 should work in most situations. However, you might need to increase the number if 
the slave device requires more preamble characters, which is generally true of older HART devices 
and can be determined using HART command 0.

8. When all HART modules are configured, click OK to close the dialog box. 
9. Choose File > Save to save the configuration file.
10. When configuration is complete, choose Tools > Send Configuration to I/O Unit.

The list on the left shows all the I/O units in this configuration file. When you click a unit, 
the Address List shows the IP addresses for all I/O units to receive the same configuration. 

11. Highlight the I/O unit configuration(s) you want to send.
12. Highlight the IP addresses to receive the I/O unit configuration.

If you don’t highlight any addresses, the configuration will be sent to the entire list.

NOTE: If you highlighted more than one unit configuration, each unit configuration will automatically be sent 
to all the IP addresses associated with it. 

13. If necessary, change the Timeout field.
The timeout field shows how long, in milliseconds, PAC Manager will try to communicate with the I/O 
unit before returning a timeout error.

14. To save the configuration file to flash memory as well as to RAM, check Save to Flash. To also restart the 
unit, check Restart I/O Unit. 

IMPORTANT: If you have changed an IP Port number, you must save the change to flash and restart the I/O unit.

15. Click Send.
The configuration data is sent to the I/O units.
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HART MODULE AND PORT NUMBERS

For quick reference, the following table shows HART modules and ports, their default TCP port numbers, and 
their starting memory map addresses, beginning with FFFF F03A 9400. For more information about the 
memory map, see the OptoMMP Protocol Guide. 

Module Port
Default 

TCP port
Memory Map 

Address
Module Port

Default 
TCP port

Memory Map 
Address

0 A 22500 9400 8 A 22516 9700

0 B 22501 9430 8 B 22517 9730

1 A 22502 9460 9 A 22518 9760

1 B 22503 9490 9 B 22519 9790

2 A 22504 94C0 10 A 22520 97C0

2 B 22505 94F0 10 B 22521 97F0

3 A 22506 9520 11 A 22522 9820

3 B 22507 9550 11 B 22523 9850

4 A 22508 9580 12 A 22524 9880

4 B 22509 95B0 12 B 22525 98B0

5 A 22510 95E0 13 A 22526 98E0

5 B 22511 9610 13 B 22527 9910

6 A 22512 9640 14 A 22528 9940

6 B 22513 9670 14 B 22529 9970

7 A 22514 96A0 15 A 22530 99A0

7 B 22515 96D0 15 B 22531 99D0
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